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Computerized Battery Analyzer
Introduction
Thank you for purchasing the West Mountain Radio CBA II, We think you will find it takes the guesswork out
of using batteries.
The CBA is much more than a simple battery voltage tester or a battery load tester. Unlike a simple load
tester the CBA will test virtually any type or size of battery, any chemistry or number of cells, up to 48 volts.
For the first time and for a reasonable price, anyone can do scientific tests of their batteries.
The CBA is capable of much higher test rates than other testers; up to 40 amps or 150 watts, whichever is
higher.
The CBA not only tests the total amount of energy stored in a battery (capacity in amp-hrs) but it graphically
displays and charts the voltage versus time using a constant current load. The graphs may be displayed,
saved and printed. Multiple test graphs of the same battery, or multiple batteries, may be compared or
overlaid, a very useful feature. The battery test data can be printed on a color or black and white printer.
You may also print convenient test labels to put directly on your batteries. The CBA will test the temperature
of a battery with the optional external temperature probe and provide automatic over temperature test cutoff.
It is ruggedly built and is supplied with 13-gauge high-grade wire with Powerpole connectors for the battery
connection. It is small and has a high performance cooling system with a quiet fan. LED indicators, visible
from across a room, display communication and test status, .
The CBA II uses an 8051 based microcontroller to measure voltage, current and temperature with high
accuracy. Each CBA is individually calibrated with an automated test system. It has 10 bit resolution in three
auto-switched voltage ranges. The current is set with 12 bit resolution below three amps and it is measured
with 10 bit above three Amps.
The electronic load uses a PWM-controlled power MOS FET with electronic current regulation and software
feedback control. The microcontroller provides an integrated plug-and-play USB interface to the computer
The software, supplied with the CBA, is easy to use and intuitive. It provides automatic sensing of the
battery cell count, a safety check of the test rate, and recommends a minimum safe discharge voltage. It is
designed to protect both the CBA and the batteries that you are testing.
We hope that you enjoy using the CBA and find it useful. You will learn valuable information about the
batteries that you test.
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Safety Precautions
The West Mountain Radio CBA is inherently safe but the batteries it tests are not. Anything that stores
energy is potentially dangerous! A can of gasoline can be safe if treated properly but imagine what can
happen. Some types of batteries are safer than others but they are all capable of causing explosions or
fires.

Primary safety considerations:
Never discharge a battery at a higher discharge rate than it is designed for.
Never use a battery that has poorly insulated or frayed wiring or exposed metal parts.
Never connect a battery with reverse polarity.
Never test a battery near flammable materials.
Never allow a battery reach a temperature that causes it to get so hot that it may be too hot to touch.
Never test or charge your batteries while unattended.
Have a fire extinguisher nearby.

CBA operating requirements:
Never connect a battery with the polarity reversed!
Always connect the USB cable BEFORE connecting the battery!
Operate the CBA in a cool dry location.
Never allow metal parts or wiring of the battery come in contact with the metal heat sink.
Never allow the cooling fan to be blocked or jammed.
Do not ignore the warnings that our software may give you.
The CBA can get hot. Do not touch the metal heat sink while, or shortly after, conducting a high
power test.

Lead acid battery safety warnings:
There may not be a consideration while testing lead acid batteries but there certainly is while charging lead
acid batteries. These batteries, especially automotive and marine types, give off explosive hydrogen gas
when charged. A nearby or internal spark or flame can cause a lead acid battery to explode sending liquid
acid and lead shrapnel in all directions. This is particularly dangerous and frequently causes blindness or
severe scarring injuries.
Never use a standard lead acid battery without proper ventilation. Sealed lead acid batteries such as gelled
or AGM (absorbed glass mat) types are much safer. Automotive and marine types are not safe and should

be used in protective ventilated housings, such as under the hood of a car.
Never make the last connection to a lead acid battery causing a spark on the terminal. Always connect the
load or charger last, and at a safe distance away from the battery.

NiCad, NiMh, and Alkaline safety warnings:
These batteries can be dangerous also. If they are shorted out, or charged or discharged at too high a rate,
they can overheat and explode. A single D size NiCad cell can actually melt a 10 penny nail, don’t try this!

Lithium safety warnings:

Reprinted with permission of the Academy of Model Aeronautics
Words in () in red were added by West Mountain Radio

Lithium Battery Fires

Lithium batteries are becoming very popular for powering the control and power systems in our models. This is true because of
their very high energy density (amp-hrs/wt. ratio) compared to NiCads or other batteries. With high energy comes increased risk in
their use. The, principal, risk is FIRE which can result from improper charging, crash damage, or shorting the batteries. All vendors
of these batteries warn their customers of this danger and recommend extreme caution in their use. In spite of this many fires
have occurred as a result of the use of Lithium Polymer batteries, resulting in loss of models, automobiles, and other property.
Homes and garages and workshops have also burned. A lithium battery fire is very hot (several thousand degrees) and is an
excellent initiator for ancillary (resulting) fires. Fire occurs due to contact between Lithium and oxygen in the air. It does not need
any other source of ignition, or fuel to start, and burns almost explosively.
These batteries must be used in a manner that precludes ancillary fire. The following is recommended:
1. Store, and charge (discharge), in a fireproof container; never in your model.
2. Charge (discharge), in a protected area devoid of combustibles. Always stand watch over the
charging (discharging), process. Never leave the charging process unattended.
3. In the event of damage from crashes, etc, carefully remove to a safe place for at least a half hour to observe. Physically
damaged cells could erupt into flame, and, after sufficient time to ensure safety, should be discarded in accordance with the
instructions which came with the batteries. Never attempt to charge (discharge) a cell with physical damage, regardless of
how slight.
4. Always use chargers designed for the specific purpose, preferably having a fixed setting for your particular pack. Many fires
occur in using selectable/adjustable chargers improperly set. Never attempt to charge Lithium cells with a charger which is not,
specifically, designed for charging Lithium cells. Never use chargers designed for Nickel Cadmium batteries.
5. Use charging systems that monitor and control the charge state of each cell in the pack. Unbalanced cells can lead to disaster if
it permits overcharge of a single cell in the pack. If the batteries show any sign of swelling, discontinue charging, and remove
them to a safe place outside as they could erupt into flames.
6. Most important: NEVER PLUG IN A BATTERY AND LEAVE IT TO CHARGE (DISCHARGE), UNATTENDED OVERNIGHT.
Serious fires have resulted from this practice.
7. Do not attempt to make your own battery packs from individual cells. These batteries CANNOT be handled and charged
casually such as has been the practice for years with other types of batteries. The consequence of this practice can be very
serious resulting in major property damage and/ or personal harm.

Again:
Primary safety considerations:
Never discharge a battery at a higher discharge rate than it is designed for.
Never use a battery that has poorly insulated or frayed wiring or exposed metal parts.
Never connect a battery with reverse polarity.

Never test a battery near flammable materials.
Never allow a battery reach a temperature that causes it to get so hot that it may be too hot to touch.
Never test or charge your batteries while unattended.
Have a fire extinguisher nearby.
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Computerized Battery Analyzer
Getting Started
We highly suggest that you read our entire help for a full understanding of the CBA!
1. From the CD ROM opening screen click on “Software and Hardware Installation”. Follow the instructions
on the screen to complete both the hardware and software installations.
2. Connect the CBA to your computer’s USB port using the supplied cable before connecting a battery.
Note: If Windows says: “Found new Hardware”, you did not complete the previous step.

3. Start the West Mountain Radio CBA program by clicking on the icon:
Note: The CBA’s green LED should come on and the program will display “Stopped" in green letters.

4. Before a new test you must type a name in the “Test Name” window that lets you identify the test. You
should use a name that describes the battery and what it is used in. Tip: We suggest that you label or number your
batteries and refer to them, and their tests, by their number. If you forget to type in a test name the program will remind you to
supply a name before allowing you to start a test Note: the ”Test Name” is not same as the file name that a test or group of tests
may later be saved under.

5. Select the correct “Battery Type” (chemistry) if that type is not already selected.
6. Select the rated “Capacity” for the battery you would like to test. For example if it is a battery rated at 600
mA-h select .6 A-h (in amperes), not mA.
7. Connect the battery. WARNING: YOU MUST CONNECT THE CBA'S USB CABLE BEFORE
CONNECTING A BATTERY! BE CERTAIN THAT YOU HAVE THE POLARITY CORRECT! RED TO RED,
BLACK TO BLACK AND PLUS TO PLUS, MINUS TO MINUS!
8. The battery voltage display will come up indicating the resting battery voltage. You will see the program
make an estimate of the number of cells. If you find that the number of cells is incorrect, correct the cell
count or battery type.
9. Choose the discharge current for the test that you would like to run in the “Test Amps” window.
CAUTION: DO NOT CHOOSE A HIGHER DISCHARGE RATE THAN THE BATTERY IS CAPABLE OF.
SEE THE BATTERY MANUFACTURE’S SPECS. Note: If the no load battery “Voltage” multiplied times the “Test

Amps” selected (Volts times Amps = Watts) exceeds the wattage rating of the CBA, or our default recommended maximum
discharge rate limits, you will be prompted to lower the discharge current before continuing. The CBA will run tests at up to 150
watts with a battery that has a rated capacity of 1 Amp-Hr or less, up to 125 watts below 3.5 Amp-Hrs and 100 watts for any
capacity battery. If the test current could be too high for the capacity rating and type of battery, you will get a warning prompt. You
may over-ride the warning recommendation at your own risk.

10. Press the green start button. If you have all the settings correct you will see the graph start to appear
and auto-scale, the measurement readings windows will change from green to red, the red LED will come
on, and the green word “Stopped” will change to a red “Running” and the fan will start. The current display
will come up to the test level, the wattage will be displayed and the Amp hours will start to accumulate as the
graph trace appears.
11. The test will continue until the “Test Cutoff V” is reached. At that point the test will automatically stop
and the program will display “Test Complete”. Everything will return to the stopped condition ready to take
your input for your next test. Disconnect the battery at this time. CAUTION: The battery and the CBA may
be HOT!
12. When the test is complete you may go to the “File” menu and save or print the file or run another test.

Note: If you close the program or try to run another test you will be asked if you wish to save the completed test already on the
screen.

13. If you wish to run another test, start at step 4 of these instructions. Upon starting another test you will
be given three choices: to discard the previous test, save and start a new test or add the new test to the
previous one. Choose the appropriate choice and the new test will start immediately.
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Computerized Battery Analyzer
The CBA program
The basic operation is covered in the “Getting Started” section of our manual / help documents. This section
gives a more detailed explanation of using the program and it’s features.
Main Screen, Test Settings:
To start a new test you must first type in a “Test Name”. Choose a name that makes it easy to identify the
battery that was tested. Tip: When completed and the file is saved, the program will save that test, with the name, along with
other information, such as; test rate, date, time and voltages. A file may be saved under another or different name, as necessary,
when there are multiple tests saved together in one file.

Next, select the “Battery Type” (Chemistry), and the rated capacity in A-h (to convert mA-h to A-h divide by
1000).
Connect the battery: the CBA will measure the no load voltage and the program will estimate the number of
cells.
The program will automatically recommend the “Test Amps” discharge rate, and a safe “Test Cutoff V”. This
is based on the battery type and capacity that you typed in and on the measured voltage. Tip: You may
optionally change the discharge rate, “Test Amps” or cutoff Voltage, however the program will “ask you if you are sure” if you
choose higher discharge rate or a lower cutoff voltage before allowing you to start the test.

Make sure that all the information, displayed across the top of the screen, is correct. If necessary, fix the
entries, before starting the test.
Press one of the green “Start” buttons to start the test.

Main Screen, Test Readings:
After starting a test you will see the current increase to the "Test Amps" level that you have
chosen. The A-h will begin to accumulate and the "Watts" will be displayed. The green
background will change to red, the word in green, “stopped”, will change to a red
“RUNNING” and the CBA fan will come on. The graph of voltage versus A-h will start to
display on the screen.The green start buttons will change to red stop buttons.
If you have the optional temperature probe connected and calibrated, the CBA will display
temperature.

File Menu:
After the completion of a test you may select “File”, “Save” and save the file under
the same or different name than the previously chosen test name.
The file menu has a special “Overlay” choice so that test comparisons may be
made. With a test already on open on the screen you may add additional tests to
the same display for battery comparison purposes by using the “Overlay” choice.
Overlay opens files that have been saved with one or more tests in them and
overlays those tests on top of the test screen that is already there. This is very
useful for comparing test results with the same battery over time or with different
batteries.
There is a “Export” function to export a test or multiple tests in the standard .CSV
(Comma Separated Values) to be imported in to another program such as
Microsoft Excel. This file export to a spreadsheet program such as Excel will allow
you to analyze the data in whatever way you choose.
There is a recently opened file list towards the bottom of the “File” menu, for your
convenience, to recall those recent files. The other “File” menu choices are standard with most Windows
programs and work as you would expect.
If you try to run another test with a previous test on the screen you
will be given a pop-up file menu with several options as shown. Be
sure to select the appropriate option.

Edit Menu:
From the “Edit” menu standard Windows edit
functions are grayed out and disabled but you may
access “Preferences...”, “Calibrate Temp Probe...”
and “Lab Calibrate”
Click on “Preferences...” to select your choice of
temperature in Degrees F. or C. for display with the
optional temperature probe.
From “Preferences...” there is an option check box that, by default, causes the program to remember its
window size and position, the next time the program is started.
From “Preferences...” there is an option check box to enable automatic test over-temperature cutoff when
the optional temperature probe senses the selected or default temperature limit being reached. Do not check
this box if you do not have a temperature probe connected and calibrated.
From “Preferences...” there is an option check box to select only black and white graph printing. Use this
option if you wish only black and white graph printing.

From the edit menu there is a option to “Calibrate Temp
Probe...“. The first time you connect an optional temperature
probe for measuring the battery temperature you must
calibrate the probe. With the temperature probe connected
(see the temperature probe help section), click “Edit”,
“Calibrate Temperature Probe” and type in the temperature in
degrees C. or in degrees F. If you do not have an accurate
reference thermometer handy just type in your estimate of the
room or probe temperature. For maximum accuracy calibrate
the probe in hot water near the temperature of interest.
From the edit menu there is a “Lab Calibrate...“ option. Lab
Calibrate is an advanced option that can only functions below
3000 ma. If you have a need for the most precise
measurements and you have access to a lab quality ammeter
that has known NBS traceable calibration you may wish to use
this option. This option allows a calibration offset to center the
CBA's calibration within a 12 bit window. In other words you
may adjust the discharge current in 1 ma increments but only within a 10 ma measurement window. You
may not see a change unless you are on the cusp of switching to the next 12 bit data level. This feature is
useful to calibrate at especially low discharge rates below 500 ma. Do not use this option unless you
understand calibration procedures.

View Menu:
The View menu allows you to toggle on or off the Toolbar at the top or the Status bar
at the bottom of the screen.

Test Menu:
From the Test menu you may start or stop a test in instead of using the
tool bar buttons.
From the Test Menu you may modify test properties. You should note
that the graphing and scaling are fully automatic and dynamically
adjusted so that you do not normally need to change the graph scaling.
You may wish to put a Title at the top of a graph or to change the “Show”
settings to display or print a graph the way you wish. The settings you
choose will remain until you re-start the program.
Manual scaling may be set by clicking “Test”, “Properties” but that option is disabled before starting a new
test from a blank screen. If you manually change the scaling of a test already on the screen automatic
scaling will be disabled for the next test that you attempt to run.
From the “Test Menu”, Properties”, you may turn off the Legend, Gridlines or the Test Cutoff Line of the
graph. Note the test cutoff line is only visible while conducting a test.

Help Menu:
The “Help” menu gives you access to these help files
directly from the program in addition to from the CDrom.

From “Help”, “About” you may check the CBA software version
and the CBA hardware and firmware revision level. This
information is useful to determine if you have the latest version or
if you need a software update. The CBA Device information helps
when you contact us for support purposes.
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Saving and Printing
Saving:
After completing a battery test, you should save it for future reference in your
computer. Go to the “File” menu and select “Save” or click on the icon that looks like
a floppy disk. The name in the “Test Name” box will be suggested as the default
name, or you may edit and pick a different file name. It is important that you choose
a name that identifies what test, or tests are contained in the saved file. Tip:
Changing the file name will not change the test name of the graphs on the screen.
If you attempt to close the program, or the test that is on the screen you, will be
asked if you would like to save that test, or tests, to a file.

If you attempt to start another test with a test on the screen the program
will give you three choices:
“Discard the previous test”
“Save the previous test”
“Add a new test to the same chart”
If you choose, “Add a new test”, you will later be able to save the tests on the screen as one file with all the
individually named tests in it. You will have the option of choosing an appropriate file name whenever you
save it.
Tip: If you open a previously saved file, with previous tests on it, you may add more tests to it. With the
“File”, “Overlay” menu choice you may open one or more previous test files and those graphs will
automatically be overlaid over the test graphs that are already on the screen. If you try and save an over-lay
screen with multiple test files on it you will be asked if you if you would like to overwrite (erase) the last file
opened and replace it. Be careful to choose what you would like.
Printing Test Graphs:
Since the CBA is able to save a file with multiple overlayed graphs we have provided the option to print in
either color or black and white. For B&W printing we provide unique tick marks on each graph to identify
each graph trace with a corresponding legend key. For color printing each graph has its own color. You
must select B&W if you wish to print on a black and white printer. Go to “Edit” and then “Preferences” and
select B&W if you would like each graph plot uniquely identified with a B&W legend keys.
After selecting the color or black and white go to the “File” menu and
select “Print Setup” and then the printer that you would like to use.
While you are there, select landscape, or if you wish portrait mode
for the print out.

Go to the “File” menu and select “Print”. You may select the number
of copies you would like and you will be given another opportunity to
select the printer.
If you wish you may go to “File”, “Print Preview” window to see how it
will look before printing. If it is OK, press “Print” at the top of the
preview window. If it is not OK, close that window and go back to
correct your printer setup.
Printing Battery Labels:
Go to “File”, “Print Setup” and select only portrait mode for your printer. The labels will always print in black
and white.
Go to “File”, “Print Labels”. You will get a pop up menu to
select which battery tests you would like to print labels for.
Highlight the ones on the left that you want and click the
right arrow >, do this for each one or select them all by
clicking >>. To remove them do the opposite.
Tip: You are selecting individual test names not files. Files
may have multiple tests in them. One label will be printed for each test and be identified by the “Test
Name”.
Load Avery 05160 or equivalent sized label sheets. There is no print preview so just click “Print” on the label
menu. It will use however many labels and sheets that are needed.
Tip: You may turn a partial sheet around in your printer if your are printing a few labels and wish to use up a
partial sheet.
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Battery Testing
Introduction
Your primary concern when using batteries is probably that they do not cause a problem by failing in
service. Of course you may have many other requirements; such as, how to get the most life out of a
battery, which batteries are best for cost, size, weight etc.. You may simply be interested in getting
maximum performance.
CBA battery tests clearly show the health of a battery measured in terms of capacity and voltage. A battery
may be tested over a wide range of discharge currents with a CBA. The time it takes to perform a test is
directly related to the discharge or rate (current in amps) but batteries have limits as to how fast you may
discharge them.
Generally the bigger (higher capacity) the battery the faster it may be discharged without overheating. The
heating of a battery during discharge or charging is a direct function of the battery's internal resistance and
larger batteries have lower internal resistance and poorly made, worn or damaged batteries have higher
internal resistance. The voltage drop due to this resistance turns in to heat with a corresponding loss of
capacity. In addition to graphing the voltage versus ampere hours our optional temperature probe will
measure the temperature indicating the power that is lost as heat. The performance due to charging
techniques, load current, temperature, and battery aging can be measured and easily interpreted by viewing
the CBA graphs.
Glossary of Terms
A basic understanding of terms used for testing batteries is needed:
Capacity: Measured in ampere hours: A-h Example: 1 amp for 1 hour is one-ampere hour. It is like the
gallons of water that are in the tank. Tip: batteries are rated in both milliamps and amps; the conversion factor from
A to mA is to multiply X 1000.

Voltage: Measured in volts: V. Volts are the International System unit of electric potential and
electromotive force. It is like the pressure in the water pipe.
Current: Measured in amperes: A. An ampere is the basic unit of electric current. It is like how much
water is flowing at an instant in time.
Wattage: Measured in watts, W. Watts = Volts X Amps. It is like the pressure and also how much water
is flowing at an instant.
Resistance: Measured in ohms, R or Ω. Resistance is like the size of the pipe, the smaller the pipe
the higher the resistance.
Time and Temperature: You should know these. Tip the CBA with the optional temperature probe may be set to read
either degrees F or C.

Connecting a battery
The CBA comes with Anderson Powerpole connectors. If you are already using these fine DC connectors
you are all set. If you are using Powerpoles that are oriented differently you may slide apart the black and
red halves and re-arrange them to match your battery. If you are using other connectors you may cut off the

Powerpoles and install your own connectors, make an adaptor or purchase adaptors from West Mountain
Radio. If you choose to use another connector it must be high performance. Poor or loose connections will
show up on the battery test as a loss of voltage and capacity, or intermittent readings.
Using the CBA program
The basic operation is covered in the “Getting Started” section of these manual/help files and detailed
information is provided in the "Program Features" section.
To start a new test you must first type in a name for the test that, in the future, will make it easy to identify
the battery that was tested. Tip: When completed and the file is saved the program will save that test with the name and
other information such as, test rate, date, time and voltages. A file may be saved under the same or different file name as the
"Test Name" as is necessary when there are multiple tests saved together in one file.

Next, select the “Battery Type” (Chemistry), and the rated capacity in A-h (to convert mA-h to A-h divide by
1000) and then connect the battery. The CBA will measure the voltage with no load and the program will
estimate the number of cells.
The program will automatically recommend the “Test Amps” to be used for discharge, and a safe “Test
Cutoff V”, based on the battery type, capacity and voltage. Tip: You may optionally change these numbers, however
the program will “ask you if you are sure”, if you choose higher discharge current or a lower cutoff voltage.

Make sure that all the information displayed across the top of the screen is correct. Fix the entries, if
necessary, before starting the test.
Press the green “Start” button to start the test.

You will see the current come up to the level that you have chosen. The A-h will begin to
accumulate and the wattage displayed. The green background will change to red, the
word in green, “stopped”, will change to a red “RUNNING” and the fan will come on.
The test will continue as the battery voltage drops and the test will complete and stop,
automatically, when it has reached the Test Cutoff Voltage.
If you have the optional temperature probe connected and calibrated it will display the
temperature of the battery. Optionally, it will end the test if you have set and reached the
maximum temperature before the test cutoff voltage.

You should note that the graphing and scaling are
fully automatic and dynamically adjusted. Manual
scaling may be set by clicking “Test”, “Properties” but
that option is disabled before starting a new test from

a blank screen. If you manually change the scaling of
a test already on the screen automatic scaling will be disabled if you attempt to run an additional test.
From “Test”, Properties” you may turn off the Legend, Gridlines or the Test Cutoff Line.

At the completion of the test you may select “File”, “Save” and save the file
under the same or different name that the test name. If you would like to run
another test you will be given several options as shown. Be sure to select the
appropriate option.

The file menu has a special “Overlay” choice so that test comparisons may be
made. With a test already on the screen or by using “Open” you may add
additional tests to the same display for battery comparison purposes by using the
“Overlay” choice. Overlay opens files that have been saved with one or more
tests in them and overlays those tests on top of the test screen that is already
there. This is very useful for comparing test results with the same battery over
time or between different batteries.
The other “File” menu choices function as you would think.
There is also a recently opened file list towards the bottom of the “File” menu.

With “Test”, “Remove Test”, when doing overlay
comparisons, you will find that you may remove
individual tests from a group of tests for
comparisons or printing.

How Often to Perform Tests:
Any time a battery has been sitting for a long period, such as months, it should be tested.
A good strategy is to measure the pack when it is new by doing a slow charge and then alternately charging
it and testing it several times (cycling), or until you get similar test results. You may wish to print a test label
for your new battery using the CBA label-printing feature.
After the battery either has been used a great deal or has been sitting for some time repeat the new battery
procedure. Overlay the graphs to determine if the battery is still performing well. If when using a battery, it
seems to work poorly, try to perform a test before using it again.

We do not recommend performing tests or cycling batteries if they are used regularly and seem to be
working well. We do recommend periodically slow charging a pack of batteries if you normally use a fast
charger. There are many battery maintenance and battery care issues that are unrelated to using a CBA.
Battery Capacity and Charger Performance Testing
Follow the “Getting Started” instructions to do your first test. The capacity in A-h is displayed both
graphically and numerically when a test is completed.
Compare the battery capacity reading in A-h to the battery capacity specifications. If your battery is perhaps
20% lower in capacity than it should be, you should be suspect. If a battery is 40 or 50% lower in capacity it
may be incompletely charged, at the end of its life, or defective. Remember that battery capacity is a
function of the charge state. You may actually be testing your charger and not the batteries, therefore the
name of this section. If all of the batteries you use with a particular charger seem poor in performance it
would be a good idea to try another charger or charging technique.
You may use the CBA to check your charging techniques or charger. Do a slow charge at a rate of 1/10 to
1/20 of the battery capacity for 24 hours. Test the battery with the CBA. Let the battery cool down
completely and do a fast charge, using the charger that you are concerned about. Let the battery cool down
again and do a second test. If you get at least the same results with your fast charger compared to slow
charging that is a good indication that your fast charger is good.
There are many pitfalls using fast chargers. A fast charger does not have X-ray vision; it cannot see
(measure) the individual voltage of each cell in a pack, only the total, the CBA cannot either. Packs of
multiple cells eventually become imbalanced. A fast charger, charges until the voltage reaches a certain
point, it shuts off when it “thinks” the entire pack is charged. These chargers will detect one cell being fully
charged before the others and shut off before the entire pack is fully charged. A fast charger may also
overcharge some cells, undercharge others. An over-discharged and unbalanced pack may have a totally
dead cell or two, when charged it will actually reverse charge the dead cells and destroy the pack.
A way to help an unbalanced pack is to charge it with a slow overnight charge. After charging, use the CBA
to discharge it to the minimum cutoff voltage for the pack and then charge it again. This is sometimes called
cycling or rejuvenating a pack. The pack will probably come back and work much better for some time.
The phenomena of packs of cells coming back to life after all the cells are properly balanced is what some
people erroneously think is memory effect.

Finding a Bad Cell in a Pack
Unfortunately, this can only be accomplished by making an electrical connection to each cell, then test them,
one at a time. Before you tear the covering off of the pack make sure it tests poorly and you have done a
slow charge before the test. Tip: Number the cells with a permanent marker and use those numbers to identify the tests.
Slow charge the pack and make connection to each cell and test them one at a time on the same graph or
do multiple tests and open all of those test files to overlay the results. It should be quite obvious which cell
or cells are bad.
Matching Cells
This is done in basically the same way as finding a bad cell. Slow charging is not necessary. Charge each
cell, in the batch of cells you are choosing from, in exactly the same way. Charge them each identically and
let each of the cells sit the same amount of time to cool before testing each one. Compare the overlaid tests
for the best match of voltage and capacity. Tip: Number the cells with a permanent marker and use those numbers to

identify the tests. It is important that you use the identical charging technique, cooling time and test method!
Look for high-grade cell holders from West Mountain Radio to make it easy to connect and test individual
cells.

Internal Resistance Testing
You can get a good idea of the quality or condition of a pack by measuring the voltage drop at different test
current levels. This will give you a measure of the packs internal resistance. High internal resistance is a
sign of a poor pack, one that gets hot and is inefficient.
Charge the pack, set the CBA, for example, to 11 A; assuming the battery is safe at that level. Run the test
for 30 seconds and record the voltage at the end of this test. Run a test again at perhaps 1 amp for another
30 seconds and record the voltage again. If the battery has .5 volts less at 11 A than it does at 1 A use
Ohms law: R=E/I. R being resistance in Ohms, E is voltage in volts and I current in amperes. The internal
resistance of the pack, in this example, would be: R = .5/10 or .05 ohms. Note that we used the difference
in current between the two tests of 10 A. The lower the resistance the better.
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Temperature Probe
Plug the probe’s two-pin connector in to the right hand two pins (closest to the LEDs) of the three available
pins in the cover slot. It does NOT make any difference which way it goes in as long as it is plugged in to
the far right two pins. The extra pins are for future options. Do NOT remove the blue jumper.
Let the probe sit in a location away from any heat source for enough time to allow it to acclimate to room
temperature. Have a good thermometer near by, if you wish, for more accurate calibration. If you do not
have a good thermometer handy set it to any room temperature reference. For laboratory quality
measurements you may wish to calibrate it near the temperature of interest by submersing the probe in hot
water along with a high accuracy thermometer.
With a temperature probe connected to the CBA, go to "Edit", "Calibrate Temperature Probe" and in either
deg C, or F, type in your reference temperature reading and push OK. Note: As long as you do not change
to a different CBA or temperature probe you should not have to calibrate the probe again. Also note that this
option will be grayed out if the probe is not connected.
To use the probe, attach it in close physical contact with the center of the battery, or battery pack that you
are testing. Hold it in place with the probe’s magnet (most round cells are magnetic), or with tape or a
rubber band. Be certain it stays in close contact with the battery during your test. The CBA temperature
readings are quite accurate over the range that a battery may be operated at, however the readings will be
incorrect if the probe is not in close contact with the battery or there is air moving over it. Unlike an instant
response IR thermometer other types of thermometers take a considerable amount of time to display their
temperature reading. There is a noticeable thermal lag with our thermistor type probe.
The CBA may be set for automatic over temperature cutoff. Place the probe on the battery. Go to “Edit”
“Preferences” and check the check box next to “Stop test when battery reaches ? deg”. The default cutoff is
140 deg. F or 60 deg C which should be safe for most battery types, be careful if you choose a higher
temperature cutoff.
WARNING: DO NOT continue a test if the "Temp:" indication reaches or exceeds the maximum temperature
specification for the battery being tested.
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Computer System Requirements
Basic Requirements:
A PC with a Pentium 233 or better
At least a 800 X 600 graphics card and display monitor
Windows 98SE, ME, NT, 2000, XP with necessary RAM
An available USB port.
Recommended:
A PC with a Pentium 333 or better.
Better than 800 X 600 graphics card and display monitor.
Windows W2000, XP with 128 MB RAM
An available USB port.
For graph and label printing:
Any Windows compatible, laser or ink jet, color or black and white, printer.
Avery 05160 labels are required for label printing.
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Trouble Shooting
CBA program indicates “Device not found” and/or CBA green LED is not on when connected and the
CBA program is running.
Windows may not have completed the CBA USB driver installation. Re-boot your computer. Plug the CBA
back in. Repeat our hardware installation instructions and try it again.
If it still doesn’t work go to “Start” “Settings” “Control Panel” “System” and navigate to Hardware Device
Manager. From the device manager scroll down to “USB Serial Buss Controllers” and expand + that list. If
you see WMR CBA as a USB device, try the following. Highlight the WMR CBA, right click and un-install it.
Disconnect it and plug it back in. Let Windows re-install automatically.
If you are not successful try another USB product on your computer if you have not used the USB port
before. If another USB device does not work either contact the computer manufacturer. If another USB
device does work contact us for support.
CBA does not indicate voltage
You may have a damaged CBA, contact us for support.
CBA gets too hot and shuts itself off
The CBA has an internal temperature monitor programmed to protect it from overheating.
Make sure that the fan is running, that nothing is blocking the cooling inlet and that it is being operated in a
cool location. Do not use it in direct sunlight or on near a heat source such as on top of the battery that your
are testing.
Do not conduct successive high current tests without letting the CBA cool down and shut off its fan between
tests.
Conducting the test at a lower rate test will help, but feel free to contact us for support.
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Support
If you cannot find the answer to a question about using the CBA here in this manual and help files, you may
get help several other ways.
Support on the web: http://www.westmountainradio.com/supportcba.htm
Operating Tips on the web: http://www.westmountainradio.com/optipscba.htm
By email: support@westmountainradio.com
By phone: 203 853 8080
By fax: 203 299 0232
By mail: West Mountain Radio, 18 Sheehan Ave., Norwalk, CT 06854
If you have a problem with your computer or USB port contact the computer manufacturer.
If you have a problem with your computer’s Windows operating system contact the computer manufacturer if
Windows came pre-installed when you purchased the computer.
If you purchased a copy of Windows and put it in your computer you should contact Microsoft directly.
If you have a problem with a battery or a product you are using with it, contact that manufacturer or supplier.

